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ARTS hydraulics software
Technical scope and problem solving examples

Introduction

ARTS is a Windows-based hydraulic analysis/design software package, developed with the
analytical needs of water and wastewater engineers in mind. It has a broad analytical scope,
covering the spectrum of hydraulic problems encountered in the design of water and wastewater
engineering infrastructure as well as incorporating special features related to the hydraulic design
of wastewater treatment systems. It is operated through a user-friendly graphical interface, that
has been designed to minimise user learning effort and, thereby, to encourage its routine use as
a computational design aid. The software provides the user with a toolbox of hydraulic objects
that can be placed on the screen and linked together to generate a schematic outline of the
hydraulic system under consideration. The coding recognises the connectivity of the system and
its boundary conditions and carries out the appropriate analysis. This document contains an
overview of ARTS and illustrates the methodology used in solving some typical problems.

Scope

ARTS caters for a comprehensive range of hydraulic analysis/design tasks, including:

Steady Pipe Flow
water/wastewater flow in:

pipe links
pipe networks
pipe manifolds

flow of sewage sludge in pipes/networks

Open Channel Flow
uniform flow in a single channel
gradually and rapidly varied flow in single and multiple channels in series
decanting channels with distributed lateral inflow
storm-overflow channels with lateral outflow

Flow Measurement Structures
hydraulic design of flumes
hydraulic design of weirs

Pumping Installations
hydraulic analysis of pump/rising main systems
multiple pump systems, variable speed pumps

Wastewater Treatment Systems
hydraulic design of individual process units
hydraulic design of a group of interconnected process units
computation of hydraulic profiles

Waterhammer Analysis
analysis and control of waterhammer pressure transients due to pump trip-out
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Features

ARTS comes with in-built features that have been developed to enhance design office
productivity and upgrade design office record-keeping. These include a unique easy-to-use
graphical interface, incorporating Auto Design and Tool-tip features, and a facility to generate
design reports, including text and graphics. Design reports can be printed in hard copy form and
can also be stored as ARTS computer files for future reference. Text and graphics from ARTS
can be exported to word processing documents for inclusion in technical reports.

USER INTERFACE

ARTS has a unique graphical design interface that enables the user to produce a schematic
representation of the hydraulic system on the computer screen, just as simply as it would be
sketched on paper. Figure 1 shows a picture of the main design screen, which includes a design
sheet, on which the hydraulic system schematic is drawn, and a tool palette from which the
component elements of the hydraulic system are selected.

The design sheet sub-window is the
ARTS workspace on which the user
constructs schematic representations of
hydraulic systems, using the objects
contained on the tool palette. Multiple
design sheets can open at the same
time and their simultaneous display on
screen can be arranged, using the
commands on the Windows menu.

The tool palette contains a selection of
buttons, which either select a tool for
drawing hydraulic objects or execute
commands that carry out specific tasks.

SKETCHING THE SYSTEM LAYOUT

In the same way that an engineer sketches a system being analysed on a sheet of paper, the
system to be analysed by ARTS is sketched on the computer screen. ARTS provides a set of
hydraulic objects, which are the building blocks for creating hydraulic systems on the screen.
These objects can be placed on the design sheet using the mouse, in a similar fashion to any
Windows drawing package. Once the hydraulic system is drawn on the screen, the appropriate
Analysis command is selected and executed, and the results are printed on the screen graphic.

The first step is to draw a sketch of the system on the design sheet. This applies whether the
hydraulic system is a single pipe or channel or a complex series of process units linked by pipes.
In all cases, the system components and configuration are communicated to ARTS by drawing a
sketch diagram on the design sheet.

Each component is placed on the design sheet by clicking on its tool button, moving the cursor
over the design sheet and clicking at the desired location. Objects can be drawn to the desired
size and can subsequently re-sized and/or moved to a new location.

Figure 1 The ARTS workspace
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Selection tool: For selecting
and manipulating objects

Properties Command Icon:
Displays the properties of the
currently selected object.

Activated Sludge Tool: For
creating an open tank type unit

GVF Command Icon:
Displays the gradually varied
flow plotter, applied to the
currently selected channel

Graph Command Icon:
Displays a graph. Used with
channels, pipes and flumes

Detritor: For creating grit
removal objects

Zoom Tool: equivalent to
selecting Zoom Area from the
View menu

Calculator Command Icon:
Displays the calculator

Manifold Tool: For creating
flow distribution unit

Flow Tool: Used to create an
inflow or outflow from a system

Pipe Tool: For creating pipes
of constant diameter

Rectangle Tool: For creating a
rectangle (Graphic only)

Channel Tool: For creating
channels of constant shape and
slope

Reservoir Tool: For creating
reservoirs of fixed water level

Biofilter Tool: For creating a
biofilter wastewater treatment
unit

Pump Tool: For creating
rotodynamic pumps

Air Vessel Tool: For creating
pressure vessels with air
cushions for use in
waterhammer control

Divider Tool: For creating a
flow-dividing chamber

Screen Tool: For creating a
water/wastewater screening
device

Flume Tool: For creating a
flow measurement device

Storm Overflow: For creating
a storm overflow channel with
side-weirs

Weir Tool: For creating a flow
measurement device

Sedimentation Tool: For
creating a primary or secondary
sedimentation unit

Text Tool: For creating text
(graphic only)

Line Tool: For creating lines

ARTS reads the connectivity of an hydraulic system from its design sheet sketch. Thus, pipe and
channel links start and end, either in another object such as a sedimentation tank or reservoir, or
at the end of another link. The code includes a built-in facility for verifying that the software is
correctly interpreting the connectivity presented graphically on the design sheet.

Examples of typical hydraulic systems, as sketched on the design sheet, are shown on Figure 2
and Figure 3.

R 1

R 2

PU 1

PU 2

P 1

P 2
P 3

P 4

P 5

R 3

J 1 J 2

J 3 J 4
J 5

J 6

J 7

J 8

Figure 2 Design sheet sketch of pump-rising main system

SCR 1
P 1

P 2

S 1

S 2

O 3

P 3

P 4

P 5

B 1

Figure 3 Design sheet schematic of a simple wastewater treatment plant
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DATA INPUT

Every hydraulic object that is placed on the design sheet has properties associated with it. These
properties are accessible via dialog boxes known as Property Pages. For example, a pipe object
has a length property, a diameter property, a surface roughness property etc. When you place an
object on the design sheet you are essentially creating
a virtual version of a real world object. For example,
when you place a pipe on the screen and then display
its Property Pages, you will find that the pipe has initial
values for all parameters relevant to its hydraulic
performance. The same holds true for all other
objects. Thus, the system drawn on the design sheet
is not just a bare graphic, such as a similar image
drawn on paper, but is backed up by a full
complement of parameter values.

Property pages come replete with graphic images, object shape options (circular or rectangular
sedimentation tank, channel shape, etc.), editable initial parameter values, and, most importantly,
a comprehensive computational capability related to the internal hydraulic behaviour of the
object. Typical examples are shown on Figure 5 and Figure 6.

Figure 4 Pipe Main Page

Figure 5 Pump Main page Figure 6 Pump HQ Page
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STEADY PIPE FLOW

ARTS provides a comprehensive suite of analytical tools for solving steady pipe flow problems,
giving the user maximum flexibility in system specification, including the insertion of fittings, such
as bends, valves etc. Provided the interconnected system of pipes is drawn correctly on the
design sheet and has a feasible set of boundary conditions, ARTS will compute the flow and
pressure distribution and print the results on the sheet graphic.

Steady flow of water/wastewater in pipe links

ARTS incorporates two computational tools, either of which may be used to display the relevant
hydraulic parameters for a pipe link, for a user-specified flow condition.

Procedure:

• Draw a pipe on the design sheet and edit its relevant properties on the Main (Figure 4) and
Extras pages.

• Click on the Status page.

The Status page, indicated in Figure 7, displays
several parameters for a given flow. The flow
value can be altered, and the other parameters
will be updated accordingly.

As an alternative to this, the Pipe
Calculator can be used to calculate any
parameter, based on all other inputs, as
illustrated in Figure 8.

Figure 7 Pipe Status page

Figure 8 The Pipe Calculator
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Example 1 Pipe headloss

Calculate the headloss in a pipe, having an ID of 605mm and a surface roughness of 0.06mm, at
a flow of 0.85m3/s. The pipe length is 3,459m and it includes four 90o short-radius bends.

Draw a pipe on the design sheet (the pipe is grey until you set some of it’s properties)

P 1

Edit the Main property page:

Edit the Extras property page:

11

22

33
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Example 1 Pipe headloss (contd)

Click on the Status page:

Solution: The headloss through this pipe is 33.65m at 0.85m3/s.

Example 2 Computation of effective roughness

An old rising main is 6580m long and has an internal diameter of 345mm. Under normal steady
state operational conditions, the flow has been measured at 0.2m3/s and the corresponding
headloss has been measured at 124.4m. Compute the effective pipe wall roughness.

This computation can be done most conveniently using the Pipe Calculator.

Draw a pipe on the design sheet

P 1

Edit the Main property page:

44

11

22
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Example 2 Computation of effective roughness (contd)

Select the Pipe Calculator, from the tools palette

Click on the Calculate k value button

Solution: the effective k value of the old rising main is 1.29mm

Pipe Networks

The ARTS graphical interface is very convenient for the analysis of flow and pressure in water
distribution networks, which may include ancillary features such as booster pumps, non-return
valves etc.

Procedure:

• Draw the system under consideration on the sheet and edit the pertinent properties of the
objects on the sheet, i.e. pipe diameters, pipe lengths, reservoir levels, pump characteristics,
etc.

• Select Steady pipe flow from the Analysis Menu.

The results of the analysis are printed on the design sheet, indicating flows in pipes, and potential
heads at nodes. This display can be modified to display velocities, headlosses, gauge pressures
etc.

95.000mOD 110.000mOD

105.000mOD

0.2122m³/s

0.2660m³/s

0.00376m³/s

0.2995m³/s

0.2957m³/s

0.0837m³/s

0.6309m³/s

0.3350m³/s

0.3794m³/s

0.2794m³/s

101.171m

108.516m

95.000m

101.174m

105.000m

100.068m

110.000m

34.548m53.099m 0.1000m³/s

0.1000m³/s

PU 1

130.000mOD

0.5144m³/s

0.5144m³/s

34.406m
130.084m

130.000m

0.0500m³/s

Figure 9 Analysed network

33

44
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Example 3 Network analysis

A small industrial estate requires a water distribution system to feed the demand points illustrated.
The system will be fed from a reservoir at 23mOD, which is 3km away. The required minimum
residual head in the system is 3m, at the following maximum demands:

1: 0.02m3/s, at 10mOD
2: 0.03m3/s, at 10.6mOD
3: 0.026m3/s, at 9mOD
4: 0.012m3/s, at 8.5mOD
5: 0.031m3/s, at 8mOD

Draw a suitable network on the sheet:

R 1

P 1

P 2

P 3
P 4

P 5

P 6

P 7

O 1

O 2
O 3 O 4

O 5
J 2

J 5

J 3

J 4

J 1

J 6

J 7

Edit the relevant properties of the objects on the sheet as follows:

Pipes
            Diameter   Length      k
Ref           (mm)       (m)      (mm)
P 1              100     60.00    0.010
P 2              100     50.00    0.010
P 3              150     10.00    0.010
P 4              220     70.00    0.010
P 5              250     55.00    0.010
P 6              200     10.00    0.010
P 7              375   3000.00    0.010

Reservoirs Supplies/Demands Nodes
             Surface             Current             Elevation
Ref          Level(m) Ref          (m³/s) Ref           (mOD)
R 1           23.0000 O 1           0.020 J 1             8.500

O 2           0.030 J 2            10.000
O 3           0.026 J 3            10.600
O 4           0.012 J 4             9.000
O 5           0.031 J 5             8.000

J 6             7.000
J 7            23.000

2

3

1

4

5

11

22
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Example 3 Network analysis (contd)

 
Select Steady Pipe Flow from the Analysis Menu

0.0134m³/s

0.00663m³/s

0.0366m³/s
0.0626m³/s

0.0746m³/s

0.0444m³/s

16.074m

14.543m

14.898m

15.122m

15.775m

16.153m
0.0200m³/s

0.0300m³/s

0.0260m³/s

0.0120m³/s

0.0310m³/s

Figure 10 Flows and Pot. heads displayed

ARTS prints the flow and head values on the design sheet graphic, as illustrated in
Figure 10.

Alternatively, you may wish to display pipe velocities and joint gauge pressures. Select
the properties tool (with no design sheet object selected); the design sheet properties
page is displayed. Select pipe/velocity and joint/gauge pressure options and press
the Update display button; the design sheet textual output is changed accordingly, as
illustrated in Figure 11.

1.703m/s

0.8438m/s

2.073m/s
1.647m/s

1.520m/s

1.412m/s

7.574m

4.543m

4.298m

6.122m

7.775m

9.153m
0.0200m³/s

0.0300m³/s

0.0260m³/s

0.0120m³/s

0.0310m³/s

Figure 11 Velocities and gauge pressures

Solution: The minimum residual head is 4.29m at demand point 2 (J 3), which is greater than
3m => OK!

33
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Pipe manifolds

Pipe manifolds with lateral branches may be designed and/or analysed in ARTS.

Procedure:

• Draw a manifold on the sheet and edit the pertinent properties.

• Click on the Status page.

The Status page displays several parameters for a given flow. The flow value can be altered,
and the other parameters will be updated accordingly.

Example 4 Manifold design example

Design a manifold to distribute 0.07m3/s, over a 10m2 area, with a maximum headloss of 200mm

Draw a manifold on the design sheet

O 1

Edit the properties, so that the manifold covers a 10m2 area:

11

22
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Example 4 Manifold design example (contd)

Click on the Status page, to check that the headloss is no more than 200mm

Solution: The headloss through the manifold is 194mm, so design is OK.

Steady flow of sewage sludge in pipes/networks

The hydraulic resistance to flow of sewage sludge in pipes is generally greater than the hydraulic
resistance of water or wastewater, at the same velocity. In particular, the suspended solids
concentration of sludge influences its viscosity and hence also its flow resistance. ARTS caters
for the normal range of sludge types, including primary, activated, humus and digested sludges.

Procedure:

• Draw the system under consideration on the sheet and edit the pertinent properties of the
objects on the sheet, i.e. pipe diameters, pipe lengths, reservoir levels, pump characteristics,
etc.

• Place a supply of sewage sludge into the system - this is done by drawing the flow object
pointing towards a node on the sheet and by setting the fluid type of the flow object to sewage
sludge and also setting the solids concentration of the sludge.

• Select Steady pipe flow from the Analysis Menu.

The results of the analysis are printed on the design sheet, indicating flows in pipes, and potential
heads at nodes. This display can be modified to display velocities, headlosses, gauge pressures
etc. The included sludge types are primary sludge, activated sludge, humus sludge and digested
sludge.

33
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Example 5 Sludge flow

Waste primary sludge from two sedimentation units is to be intermittently transferred to a sludge
thickening tank by gravity at a minimum rate of 0.01m3/s. The sedimentation tank TWLs are
24.1mOD. The sludge thickening tank cannot be located closer than 35m from the sedimentation
units. The TWL of the sludge thickening tank is 22.2m. The sludge is expected to have a solids
concentration of 30kg/m3. Allow for three 90o elbows in the pipework.

Draw the following system on the screen

R 1

R 2

P 1

P 2

P 3

O 1

J 1

J 2

J 3

J 4

O 2

O 3

Edit the properties of the objects on the screen*:

Pipes
            Diameter   Length      k      Total      No.
Ref           (mm)       (m)      (mm)      K     Fittings
P 1               75      5.00    0.010    0.000         0
P 2               75      5.00    0.010    0.000         0
P 3              110     30.00    0.010    3.750         3

Nodes
            Elevation
Ref           (mOD)
J 1            24.100
J 2            20.000
J 3            24.100
J 4            20.000

Supplies/Demands
            Current  Maximum  Minimum
Ref          (m³/s)   (m³/s)   (m³/s)           Type
O 1           0.010    0.150    0.004  Primary sludge @ 30.000kg/m³
O 2           0.005    0.150    0.000  Primary sludge @ 30.000kg/m³
O 3           0.005    0.150    0.002  Primary sludge @ 30.000kg/m³

Reservoirs
             Surface
Ref          Level(m)
R 1           24.1000
R 2           24.1000

* this listing, which follows this heading, is a copy of the printed textual output from ARTS for this example.

11

22
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Example 5 Sludge flow (contd)

Select Steady Pipe Flow from the Analysis menu

24.100mOD

24.100mOD

0.00500m³/s

0.00500m³/s

0.01000m³/s

0.01000m³/s

24.100m

23.860m

24.100m

22.440m

0.00500m³/s

0.00500m³/s

Solution: The calculated TWL at the thickening tank is 22.440mOD, so the current design is OK.

33
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OPEN CHANNEL FLOW

The ARTS open channel analysis/design capability extends to the computation of uniform flow,
gradually varied and rapidly varied flow in channels of rectangular, trapezoidal, U-shaped, V-
shaped, parabolic and circular sections. It includes plotting of flow profiles in single channels and
also multiple channels in series.

Uniform flow

ARTS provides a uniform flow analysis capability through the channel object’s property pages.

Procedure:

• Draw a channel on the design sheet and edit its relevant properties on the Main page.

• Click on the Status page

The Status page displays several parameters for a given flow. When a new value is entered in
the flow box, ARTS automatically updates the dependent parameter values.

Example 6 Uniform flow in an open channel

Calculate the normal depth in a concrete U-shaped channel, which has a base width of 1200mm,
a gradient of 1 to 1500 and is used to convey sewage at a flow rate of flow 1.65m3/s.

Place a channel on the design sheet (the channel is grey until you set some of it’s properties)

C 1

Display the Main property page and edit its parameter values:

11

22



17

Example 6 Uniform flow in an open channel (contd)

Display the Status page and change the flow value to 1.65 m3/s; ARTS automatically
updates the remaining parameter values:

Solution: The uniform flow depth is 1318mm at 1.65m3/s.

Computation of water surface profiles in gradually varied flow

ARTS provides means of calculating gradually and rapidly varied surface profiles in channels.

Procedure:

• Draw a channel on the design sheet and edit its relevant properties on the Main page.

• With the channel selected, click on the Channel GVF tool

This displays a dialog box which enables you to examine the surface profile in the channel with
various boundary conditions, such as upstream depth and/or downstream depth and/or lateral
flow.

Example 7 Gradually varied flow in an open channel

A sluice gate has a gate opening of 375mm and a discharge of 2.85m3/s. Check if a hydraulic
jump occurs downstream in a concrete rectangular channel, which has a base width of 2500mm,
a gradient of 1 to 800 and is 20m long. The channel discharges freely to a sump.

Place a channel on the design sheet (the channel is grey until you set some of it’s properties)

C 1

33

11
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Example 7 Gradually varied flow in an open channel (contd)

Display the Main property page and edit its property values:

Display the Status page and enter the flow value of 2.85 m3/s; ARTS updates the remaining
parameter values:

NB: The critical depth is 510mm at 2.85m3/s.

With the channel selected (has handles), click on the Channel GVF tool

22

33

44
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Example 7 Gradually varied flow in an open channel (contd)

Set the boundary conditions for the channel as displayed:

Solution: A jump occurs at 13.1m downstream from the sluice gate.

Example 8 Gradually varied flow in a series of channels

An open channel culvert, which has a free discharge at its outlet end, is 30m long and is made up
of three segments, each of which has a different slope. Determine the water surface profile in the
culvert at a discharge of 3.5 m3/s.

Place a series of channels on the design sheet:

C 1

C 2

C 3

O 1

J 1
J 2

J 3

J 4

55

11
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Example 8 Gradually varied flow in a series of channels (contd)

Edit the properties of the channels as follows:

Channels
                   Width  Height   Length  Angle  k value
Ref          Type   (mm)   (mm)     (m)    (deg)    (mm)      Slope
C 1   Rectangular   3000    2500    10.00    n/a    1.000    1:1000
C 2   Rectangular   3000    2500    10.00    n/a    1.000     1:500
C 3   Rectangular   3000    2500    10.00    n/a    1.000     1:800

Supplies/Demands
            Current  Maximum  Minimum
Ref          (m³/s)   (m³/s)   (m³/s)
O 1           0.100    3.500    0.050

Select Hydraulic Profile @ max flow from the Analysis menu

ARTS computes the water surface profile, starting from a control depth and specified
channel invert elevation at the downstream end of the system. In this example, the
control depth is the calculated critical depth (free discharge) and the default channel
invert elevation of 100 mOD. This latter value can be edited, using the property pages
for the outlet node point, J4.

C 1

C 2

C 3

3.500m³/s

100.654m

100.618m

100.596m

100.517m

The potential heads are displayed at each joint

Select the Properties tool (with no object selected) and the sheet properties will be
displayed. You can then choose to display Joint Depths, as indicated:

C 1

C 2

C 3

3.500m³/s

612mm

586mm

584mm

517mm

22

33

44
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Decanting channels with distributed lateral inflow

Decanting channels are normally built in features of treatment process units, such as
sedimentation tanks. Where a treatment unit incorporates a decanting channel, ARTS provides
for its hydraulic design as an integral part of the hydraulic design of the treatment unit as a whole.
Where a designer wants to analyse/design a decanting channel as a standalone object, this can
be done using the Channel GVF plotter as illustrated in Example 9.

Procedure:

• Draw a channel on the design sheet and edit its properties.

• Select the Channel GVF tool

• Set the boundary conditions and click Plot Profile.

Example 9 Decanting channel design

Design a 10m long decanting channel to accommodate 0.02m3/s at peak flow.

Place a channel on the design sheet (the channel is grey until you set some of it’s properties)

C 1

Display the Main property page and edit its property values:

11

22
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Example 9 Decanting channel design (contd)

Display the Status page and enter the flow value of 0.02m3/s; ARTS updates the remaining
parameter values:

NB: The critical depth is 87mm at 0.02m3/s.

With the channel selected (has handles), click on the Channel GVF tool

Set the boundary conditions for the channel as displayed:

Solution: A decanting channel of 250 x 250 with a slope of 1:2000 will pass 0.02m3/s, with a
freeboard at the upstream end of 114mm.

33

44

55
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Storm-overflow channels with lateral outflow

The ARTS storm overflow weir object tool has been coded to facilitate the interactive design of
lateral overflows, such as used to regulate the maximum forward flow to full treatment at
wastewater treatment plants. Based on a specified downstream control depth (such as might be
provided by a flow measurement flume), a specified forward flow to treatment and a specified
weir length, ARTS computes the required weir crest level.

Procedure:

• Draw a storm channel on the design sheet.

• Edit the various properties.

• Click on the Status page to check the storm overflow.

Example 10 Design of a storm overflow weir

Design a 16m long channel with side weirs to limit the FFT to 5.0m3/s, at a peak storm  flow of
9.75 m3/s. Downstream of the channel is a flume, which creates an upstream depth of 1500mm
at 9.75m3/s.

Draw a storm channel on the design sheet.

O 1

Edit the properties on the Main page:

11

22
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Example 10 Design of a storm overflow weir (contd)

Edit the properties on the Section page:

Edit the properties on the Side page and press the Calculate Weir Height button

The required weir height is 1138mm.

Click on the Status page to display the computed performance:

Solution: A weir height of 1138mm produces a storm overflow of 4.75m3/s as required.

33

44

55
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FLOW MEASUREMENT STRUCTURES

ARTS enables the design of a wide range of open channel flow measurement structures,
including flumes and weirs. The range of flumes catered for includes long-throated flumes of
rectangular, trapezoidal and U-shaped section, short-throated flumes of rectangular section, and
Parshall flumes. The range of weirs catered for includes rectangular, broad-crested, v-notch and
sutro weirs. Both flumes and weirs can be design/analysed on a stand alone basis or incorporated
into a system.

Hydraulic design of flumes

ARTS incorporates an easy-to-use design procedure for flumes. The software creates an initial
valid design which can then be altered by following limits which are displayed via tooltips. This
ensures a final valid design, in accordance with specified design rules.

Procedure:

• Draw a flume on the design sheet.

• Edit the various properties in sequence, starting at Main, then Channels, then Throat, then
Side and Plan.

• Click on the Status page to check that the design is valid.

Example 11 Designing a flume

Design a rectangular flume to measure flow in the range 3 - 5 m3/s. The flume is to fit into a 3m
wide by 2m deep channel which has a slope of 1:800.

Place a flume on the design sheet.

O 1

11
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Example 11 Designing a flume (contd)

Edit the Main and Channels pages:

Press the Setup button and then edit the properties on the Throat page:

Edit the Plan page:

22

33

44
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Example 11 Designing a flume (contd)

Check the Calibration page and the Status page to ensure a valid design:

Hydraulic design of weirs

ARTS caters for a range of weirs, including broad-crested weirs and thin plate weirs; the latter
category includes proportional flow weirs, rectangular notch and V-notch weirs.

Procedure:

• Draw a weir on the design sheet.

• Edit the various properties, starting at Main, then Channels, then Section, then Side and
Plan.

• Click on the Status page to check that the design is valid.

Example 12 Designing a weir

Design a V notch weir to measure the flows from a small stream to a proposed trout farm. The
fish tanks require a minimum flow of 86.4m3/day.

Place a weir on the design sheet.

O 2

55

11
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Example 12 Designing a weir (contd)

Edit the Main and Channels pages:

Press Setup and edit the Section page

Edit the Side page:

22

33

44
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Example 12 Designing a weir (contd)

Check the Calibration and Status Pages:55
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PUMPING INSTALLATIONS

HYDRAULIC ANALYSIS OF PUMP/RISING MAIN SYSTEMS

ARTS treats pump/rising main systems as sub-sets of pipe networks and hence can analyse
complex rising mains as well as multiple pumps and variable pump speed.

Example 13 Rising main pump duty point

Check the duty point of the pump Model PU45 when used to pump from a low level reservoir at
23.4mOD to 43.6mOD through a 2km, 250mm ID rising main. The manufacturer’s data sheet for
the pump is illustrated. The pump is connected to the rising main by a 5m long, 200mm ID pipe
(with1 x 90o elbow, 1 x NRV, 1 x taper transition 200/250), and connected to the sump by a 4m
long, 250mm ID pipe (with 1 x 90o elbow).

0 20 40 60 80 100 120 140
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Figure 12 HQ curve for PU45 (@ 1490rpm)

Draw the system on the design sheet.

R 1

R 2

PU 1

P 1

P 2

P 3

J 1J 2
J 3

J 4

J 5

Edit the properties as follows:

Pipes
            Diameter   Length      k      Total      No.
Ref           (mm)       (m)      (mm)      K     Fittings
P 1              250      4.00    0.010    0.000         0
P 2              200      5.00    0.010    2.850         2
P 3              250   2000.00    0.010    0.000         0
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Example 13 Rising main pump duty point (contd)

Nodes
            Elevation
Ref           (mOD)
J 1            22.000
J 2            23.400
J 3            22.000
J 4            22.000
J 5            43.600

Reservoirs
             Surface
Ref          Level(m)
R 1           23.4000
R 2           43.6000

Edit the pump properties on the Main, Head and Power property pages, using data supplied.

Note: information on the pump moment of inertia is not required for steady flow
analysis, hence, it is not necessary to edit the value for this parameter.

Select the Steady Pipe Flow command from the Analysis menu; ARTS prints the flow and
potential head values on the design sheet graphic, as shown.

23.400mOD

43.600mOD

PU 1

0.0533m³/s

0.0533m³/s

0.0533m³/s

23.385m23.400m
51.484m

51.012m

43.600m

Solution: The duty point flow is 0.0533m3/s.
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Multiple pump systems, variable speed pumps

Analysis of systems with multiple pumps or systems with variable speed pumps is done in a
similar manner to plain pump/rising main systems.

Procedure:

• Draw the system on the design sheet.

• Edit the relevant properties

• Select the Steady pipe Flow from the Analysis menu.

Example 14 Multiple pumps

Determine the flow in the previous example if a second pump is added to the system in parallel.

Copy the pump on the design sheet from the previous example, and paste the copy onto the
sheet. Do the same with the suction pipe and the delivery pipe.

Move the elements around to get the system below:

R 1

R 2

PU 1

P 1

P 2

P 3

J 1J 2
J 3

J 4

J 5

PU 2

P 4
P 5

J 6
J 7

J 8

Select the Steady Pipe Flow command from the Analysis menu; ARTS prints the flow and
potential head values on the design sheet graphic, as illustrated.

23.400mOD

43.600mOD

PU 1

0.0350m³/s

0.0350m³/s

0.0685m³/s

23.393m23.400m
55.583m 55.378m

43.600m

PU 2

0.0335m³/s
0.0335m³/s

55.887m
23.394m

23.400m

Solution: The duty point flow for two pumps is 0.0685m3/s.
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Example 15 Variable speed pumps

Determine the pump output in the previous example if one of the pumps is operated at a reduced
speed of 1300rpm.

Using the design sheet from the previous example, edit the Current speed of one of the
pumps.

Select Steady Pipe Flow from the Analysis menu.

23.400mOD

43.600mOD

PU 1

0.0495m³/s

0.0495m³/s

0.0567m³/s

23.387m23.400m
52.346m 51.937m

43.600m

PU 2

0.00717m³/s
0.00717m³/s

51.960m
23.400m

23.400m

Solution: The combined pump output with one pump at 1300rpm is 0.0567m3/s.
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WASTEWATER TREATMENT SYSTEMS

ARTS can compute WWTP TWLs, starting from a downstream elevation or TWL for single or
multi-stream WWTP. Graphs of hydraulic profiles can be plotted for single stream WWTPs.
Analysis can also be carried out on individual units, isolated from a system.

Hydraulic design of individual process units

In ARTS, the property pages for the individual treatment unit objects enable the user to carry out
an internal hydraulic design of the treatment unit, for example, the sequence of property pages
for the sedimentation object allow the user to select the sedimentation tank shape and plan
dimensions, select the type of peripheral overflow weir and compute its dimensions, design the
external peripheral collector channel and compute the head loss across the treatment unit

Procedure:

• Draw a unit on the design sheet.

• Edit the relevant properties

• Select the Status page

Example 16 Hydraulic design of a Sedimentation unit

Design a secondary sedimentation unit to cater for a maximum wastewater inflow of 0.15m3/s
and a recycle flow of 0.7m3/s. The tank is to have a rectangular plan shape, with outflow over a
weir spanning the full tank width. The weir overflow should discharge into a collector channel with
a central outlet.

Draw a sedimentation unit on the design sheet.

S 1

Edit the properties on the Main page:

11
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Example 16 Hydraulic design of a Sedimentation unit(contd)

Edit the properties on the Outlet page:

Edit the properties on the Collector page:

Click on the Status page to check the headloss through the unit at maximum flow:
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Hydraulic profile computation for wastewater treatment plant (WWTP)

The Analysis menu has an Hydraulic Profile sub-menu that has been designed for the
computation of hydraulic profiles across WWTPs, enabling the user to:

• Carry out a detailed hydraulic analysis/design of the components of a wastewater treatment
system, including the process units and the inter-connecting links.

• Set the relative elevations of the treatment process units that comprise the treatment system,
to permit gravity flow through the system, at all flows up to a specified maximum design flow

• Compute the hydraulic profile for flow through the system at any flow rate between the
specified maximum and minimum flow rates.

Provision is made for the sub-division of flow into parallel streams, using the Flow-divider tool,
and also for the re-combination of flows into a single stream. “Drops” may be incorporated into
the treatment system layout to cater for varying site topography

Procedure:

• Draw a process system on the design sheet.

• Edit the relevant unit and link properties

• Select Hydraulic profile at max flow

• Select Hydraulic profile at min flow

Example 17 Computation of an hydraulic profile for a WWTP

A  municipal WWTP, having a design capacity of 30,000PE, incorporates the following processes:
screening, flow measurement, primary sedimentation, stream extended aeration, secondary
sedimentation. The wastewater is pumped to the WWTP inflow chamber; the effluent is
discharged to a receiving water having a maximum TWL of 12.60 mOD. It is required to
determine the design TWL for the WWTP inflow chamber. The process flow is to be split into two
stream downstream of the flow measurement device.

Draw a system on the design sheet, using a flow divider to split the flow.

O 1

P 1
SCR 2

P 2

O 3

P 3

O 4

S 1

S 2

S 3

S 4

P 4

P 5
O 5

O 6

P 6

P 7

P 8

P 9 P 10

P 11
P 12

R 1

J 1

J 2
J 3 J 4 J 5 J 6

J 7

J 8

J 9

J 10
J 11

J 12

J 13

J 14

J 15 J 16 J 17 J 18

J 19
J 20 J 21 J 22
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Example 17 Hydraulic profile for a WWTP (contd)

Set the properties of the Inflow:

Set the Recycle flows in each of the activated sludge units to 0.04m3/s and the Underflow
in each of the sedimentation units to 0.04m3/s.

Select Auto design from the Analysis > Hydraulic Profile menu

This command sizes units and links to approximately correct values, creating an initial
design, which you could then edit.

Edit the TWL of the downstream reservoir to 12.60mOD. This simulates a receiving water.

This TWL determines the elevations and TWLs of all upstream objects.

Select Hydraulic profile @ Max Flow

This command calculates the required elevations and TWLs relative to the specified
downstream receiving water TWL and displays the results on screen.

0.2000m³/s

P 1
SCR 2

P 2

O 3

P 3

O 4

S 1

S 2

S 3

S 4

P 4

P 5
O 5

O 6

P 6

P 7

P 8

P 9 P 10

P 11
P 12

R 116.184m 15.949m

15.849m

15.528m

15.317m

14.995m 14.695m

14.323m

14.695m

14.323m

13.026m

12.835m

13.026m

12.600m

14.137m 13.765m
13.553m

13.212m

14.137m 13.765m
13.553m 13.212m
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Example 17 Hydraulic profile for a WWTP (contd)

Select Hydraulic profile @ Min Flow

This command calculates TWLs starting from the downstream node, checks that
pipes are fully submerged and displays the results on screen.

0.0400m³/s

P 1
SCR 2

P 2

O 3

P 3

O 4

S 1

S 2

S 3

S 4

P 4

P 5

O 5

O 6

P 6

P 7

P 8

P 9
P 10

P 11
P 12

R 1
15.432m 15.422m

15.322m

15.308m

14.943m

14.929m 14.326m

14.309m

14.326m

14.309m

12.619m

12.610m

12.619m

12.600m

13.759m 13.742m
13.263m

13.198m

13.759m 13.742m
13.263m 13.198m

Examine the text output using the Text output command on the View menu

Dividers
            Width  Length   No. Crest Level
Ref          (mm)   (mm)   Divs       (mOD)
O 4          1793    3587     2      14.895

Nodes
            Elevation                  Elevation
Ref           (mOD)        Ref           (mOD)
J 1            15.060      J 12           12.091
J 2            15.050      J 13           12.359
J 3            14.950      J 14           12.228
J 4            14.936      J 15           13.499
J 5            14.570      J 16           13.482
J 6            14.557      J 17           12.953
J 7            14.066      J 18           12.888
J 8            14.050      J 19           13.499
J 9            14.066      J 20           13.482
J 10           14.050      J 21           12.953
J 11           12.359      J 22           12.888

Flumes

  Ref:                               O 3
  Discharge Equation: Q = 1.167(H^1.750)
  Invert level:                   15.162 mOD

Sedimentation Units

  Ref:                               S 1
  Max TWL:                        14.323 mOD
  Min TWL:                        14.309 mOD
  Weir/orifice level:             14.302 mOD
  Max Sump TWL:                   14.137 mOD
  Min Sump TWL:                   13.759 mOD

  Ref:                               S 2
  Max TWL:                        14.323 mOD
  Min TWL:                        14.309 mOD
  Weir/orifice level:             14.302 mOD
  Max Sump TWL:                   14.137 mOD
  Min Sump TWL:                   13.759 mOD

  Ref:                               S 3
  Max TWL:                        13.212 mOD
  Min TWL:                        13.198 mOD
  Weir/orifice level:             13.191 mOD
  Max Sump TWL:                   13.026 mOD
  Min Sump TWL:                   12.619 mOD

77

88



39

Example 17 Hydraulic profile for a WWTP (contd)

Sedimentation Units

  Ref:                               S 4
  Max TWL:                        13.212 mOD
  Min TWL:                        13.198 mOD
  Weir/orifice level:             13.191 mOD
  Max Sump TWL:                   13.026 mOD
  Min Sump TWL:                   12.619 mOD

Activated Sludge Units

  Ref:                               O 5
  Max TWL:                        13.765 mOD
  Min TWL:                        13.742 mOD
  Weir/orifice level:             13.712 mOD
  Max Sump TWL:                   13.553 mOD
  Min Sump TWL:                   13.263 mOD

  Ref:                               O 6
  Max TWL:                        13.765 mOD
  Min TWL:                        13.742 mOD
  Weir/orifice level:             13.712 mOD
  Max Sump TWL:                   13.553 mOD
  Min Sump TWL:                   13.263 mOD

Solution: The computed TWL for the WWTP inflow chamber at max flow is 14.976mOD,

Hydraulic profile plot

ARTS can create a plot of the hydraulic profile through a group of units.

Procedure:

• Draw a process system on the design sheet.

• Edit the relevant unit and link properties

• Select Hydraulic profile @ max flow

• Select Hydraulic profile @ min flow

• Select Hydraulic profile > Plot linear profile
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Example 18 Plotting of hydraulic profile for a WWTP

Modify the previous example to a single stream system and plot the hydraulic profile of the
previous example at max and min flows of 0.1m3/s and 0.02m3/s.

With the previous example design sheet, delete one of the activated sludge streams:

O 1

P 1
SCR 2

P 2

O 3

P 3

S 2

S 4
P 5

O 5

P 6 P 8
P 9 P 10

R 1
J 1 J 2

J 3

J 4

J 5

J 10

J 11 J 14

J 15 J 16
J 17

J 18
J 23

J 24

Set the max and min flows of the flow object, and adjust the min flow value of the flume.

Select Hydraulic Profile > @ max flow

Select Hydraulic Profile > @ min flow

Select Hydraulic Profile > Plot linear profile

HG plot for Sheet 1

P
o

ten
tial H

ead
 (m

)

0 5 10 15
12.00

12.50

13.00

13.50

14.00

14.50

15.00

15.50

J 1
J 2
J 3

J 4
J 5 J 23

J 10

J 15

J 16

J 17

J 18

J 11

J 24
J 14

- Max
- Min

11

22

33

44

55



41

WATERHAMMER ANALYSIS

ARTS incorporates an analytical capability for the computation of the transient pressure
fluctuation in rising mains caused by sudden pump trip-out. Rising mains may include
waterhammer control devices such as air vessels and/or air valves. Where waterhammer
protection is required, it is commonly provided by the installation of an air vessel, connected to
the rising main at its upstream end.

ANALYSIS AND CONTROL OF WATERHAMMER PRESSURE TRANSIENTS

Procedure:

• Draw the system the design sheet.

• Edit the relevant properties

• Select Unsteady Pipe Flow from the Analysis menu

Example 19 Waterhammer example

A pump is required to lift sewage from a pump sump, TWL -2.5 mOD to the inlet chamber of a
WWTP at TWL 13.00 mOD. The ductile iron rising main is 1502m long, has an ID of 300mm and
a wall thickness of 7.2mm. It is required to compute the pressure transients resulting from sudden
pump trip-out. The profile of the main is as follows:

Chainage        Elevation

(m) (mOD)

165 0.00

700 2.00

750 1.80

1200 3.50

1501              12.00

Draw the system on the design sheet

R 1

R 2

PU 1

P 1

P 2

P 3

J 1
J 2

J 3

J 4

J 5
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Example 19 Waterhammer example (contd)

Edit the properties as indicated below

Pipes
            Diameter   Length      k      Total
Ref           (mm)       (m)      (mm)      K
P 1              250     10.00    0.010    0.500
P 2              250      6.00    0.010    9.600
P 3              300   1502.00    0.100    4.000

Nodes
            Elevation
Ref           (mOD)
J 4            -1.000

Reservoirs
             Surface
Ref          Level(m)
R 1           -2.5000
R 2           13.0000

Pumps
                              Moment of
            Elevation  Speed   Inertia
Ref           (mOD)    (rpm)    (kgm²)
PU 1           -2.000   1490      0.550

Edit the Extras page of the rising main to include the profile:

Select Unsteady Pipe Flow from the Analysis menu and edit the dialog:
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Example 19 Waterhammer example (contd)

The computed results are summarised by three graphical outputs and one textual summary
as illustrated:

System & Pump Curves
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Example 19 Waterhammer example (contd)

Unsteady Flow Analysis Summary
Maximum gauge pressure of 30.12 m occurs at pump.
Check recommended design limits for maximum allowable gauge pressures and maximum allowable pressure
amplitude fluctuation in selected pipes.
Note: Rising main experiences cavitation, waterhammer protection required.

Boundary conditions:
  Mean sump water level:                    -2.500 m
  Rising main delivery level:               13.000 m
  => Static Lift:                           15.500 m

Pump data:
  Number of pumps:                               1
  Standard pump speed:                        1490 rpm
  Pump duty point head:                     22.355 m
  Pump duty point discharge:                277.17 m³/h
  Moment of inertia of pump set:             0.550 kg.m²
  Pump elevation:                           -1.000 m

Rising main:
  Length:                                 1502.000 m
  Internal diameter:                         300.0 mm
  Wall thickness:                              7.2 mm
  Wall roughness:                            0.100 mm
  total k-value:                             4.000
  Youngs' modulus:                        1.50E+11 N/m²

Pumphouse pipework:
Suction
  Pipe Ref.:                                   P 1
  internal diameter:                         250.0 mm
  length:                                   10.000 m
  wall roughness:                            0.010 mm
  total k-value:                               0.5

Delivery
  Pipe Ref.:                                   P 2
  internal diameter:                         250.0 mm
  length:                                    6.000 m
  wall roughness:                            0.010 mm
  total k-value:                               9.6

Computational details:
  No iterations:                              2000
  No divisions:                                100

Example 20 Waterhammer example, incorporating an air vessel

It is required to examine the waterhammer control effect, on the pump/rising main system in
example 19, of using a 2m3 air vessel.

Add an air vessel and connecting pipe to the system on the design sheet

R 1

R 2

PU 1

P 1

P 2

P 3

J 1
J 2

J 3

J 4

J 5

AV 1

P 4

J 6

11
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Example 20 Waterhammer example, incl air vessel (contd)

Edit the properties of the new objects as follows

Pipes
            Diameter   Length      k      Total      No.
Ref           (mm)       (m)      (mm)      K     Fittings
P 4              100     10.00    0.010    0.100         0

Air Vessels
            Diameter  Height   Total     Air     Water
Ref           (mm)     (mm)   Vol(m³)  Vol(m³)  Hgt (mm)
AV 1            1366    1366    2.000    0.389      1100

Nodes
            Elevation
Ref           (mOD)
J 6             1.000

Select Unsteady Pipe Flow from the Analysis menu

Check the various graphs produced
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Example 20 Waterhammer example, incl air vessel (contd)

Check the text output

Unsteady Flow Analysis Summary

Maximum gauge pressure of 45.09 m occurs at pump.
Check recommended design limits for maximum allowable gauge pressures and maximum allowable pressure
amplitude fluctuation in selected pipes.

Boundary conditions:
  Mean sump water level:                    -2.500 m
  Rising main delivery level:               13.000 m
  => Static Lift:                           15.500 m

Air vessel installed:
  Throttle pipe diameter:                      100 mm
  Throttle pipe total k-value:                 0.1
  Total volume:                              2.000 m³
  Air volume at steady flow:                 0.389 m³
  Max. expanded air volume:                  1.008 m³

Pump data:
  Number of pumps:                               1
  Standard pump speed:                        1490 rpm
  Pump duty point head:                     22.355 m
  Pump duty point discharge:                277.17 m³/h
  Moment of inertia of pump set:             0.550 kg.m²
  Pump elevation:                           -1.000 m

Rising main:
  Length:                                 1502.000 m
  Internal diameter:                         300.0 mm
  Wall thickness:                              7.2 mm
  Wall roughness:                            0.100 mm
  total k-value:                             4.000
  Youngs' modulus:                        1.50E+11 N/m²

Pumphouse pipework:
Suction
  Pipe Ref.:                                   P 1
  internal diameter:                         250.0 mm
  length:                                   10.000 m
  wall roughness:                            0.010 mm
  total k-value:                               0.5

Delivery
  Pipe Ref.:                                   P 2
  internal diameter:                         250.0 mm
  length:                                    6.000 m
  wall roughness:                            0.010 mm
  total k-value:                               9.6

Computational details:
  No iterations:                              3000
  No divisions:                                100

End

55



47

Example 21 Generating a custom report in other applications

Customise the graphs produced in the previous example and create a document in a word
processing package.

Select the design sheet

• With nothing on the design sheet selected, select Edit > Copy

• Paste into a word processing program

Select the Max & Min pressures in the rising main graph

• Select Copy > Data from the Edit
menu

• Start a spreadsheet package, such
as Microsoft Excel

• In the spreadsheet package, select
Edit > Paste

• Create a graph of Max Pressure,
Min Pressure and Main Elevation

• Copy the graph to the Windows Clipboard

• Paste into a word processing program

Select the Waterhammer results window

• Select Edit > Copy

• Paste into a word processing program,
below the graph

• Edit the text to suit

11

22

Custom Graph created in Microsoft Excel
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